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Getting Started  

Thank you for your purchase of  a QSI Camera. 

The QSI 500/600 Series family of cooled CCD cameras is designed to produce scientific-
grade images with wide dynamic range, excellent linearity and low noise.   Your QSI 
camera will provide years of service if properly treated and maintained. To get the most 
from your camera, we recommend that you read this User Guide thoroughly and follow the 
included precautions. 

If youôre in a hurry to try out your new camera and are familiar with the general operation of 
CCD cameras, this ñGetting Startedò section provides the basic information you will need to 
setup your camera and take your first image.  Please refer to the full User Guide and the 
online help provided with MaxIm LE for complete instructions. 

 

 

 

The QSI 5 00 /600  Series Camera  Family  Showing Different  Body Configurations  

Section  

1 
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Whatõs In the Box? 

Your QSI 500/600 Series camera was shipped in a water-tight Pelican case with custom-cut 
foam to provide the ultimate in protection.  Please take a few minutes to examine your 
camera to make sure that it has arrived in good condition, and that the case contains the 
items listed below. Note that additional items purchased at the time of order may be 
included as well. 

Á Camera body  

Á Nosepiece   2ò or 1 ıò  depending on configuration 

Á Mounting Adapter  Standard T-Mount, or optional mounting adapter 

Á Body cap  Matching body cap for Mounting Adapter  

Á AC Power A dapter  Universal AC power supply (100-240VAC, 50-60Hz) with 

detachable, region-specific AC power cord 

Á USB Cable  10 ft. USB 2.0 cable 

Á Guider Cable  10 ft. guider cable with modular connectors on each end 

Á Tools  Tool kit for camera maintenance   

Á Documentation envelope containing  the following : 

Á Quick Start Guide 

Á CD-ROM containing the Installation program, MaxIm LE, the USB and 
camera drivers, and the Installation Guide and this User Guide in PDF format. 

Á (Optional) A document with the license information for any licensed software, 
such as MaxIm LE or MaxIm DL. 
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Open Pelican case showing QSI camera and standard accessories  

Get to Know Your Camera  

 

Take a few minutes to familiarize yourself  with the external 
connections and features of your camera. 

 
 
 

 
 
 

 

 

 

 

The image above shows the major external features of a typical QSI 500/600 Series 
camera with a 5-position internal color filter wheel. The depth of the Camera Cover on your 
camera may differ depending on the internal options installed.  8-position CFW models 
have a larger front cover.  See the ñQSI 500/600 Series WSG User Guide Supplementò for 
additional details on WSG models with the Integrated Guider Port. 
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Install Software and Drivers  

The USB drivers and associated software included on the installation CD-ROM must be 
installed before connecting your QSI camera to your computer. 

Note : Do not connect your camera to your  computer until instructed to do so 

during the camera installation process.  

Confirm Installation and Camera Operation  

After the successful installation of the camera and the associated software is complete, you 
can quickly test your camera with MaxIm LE or your software application of choice. Leave 
the camera USB cable and power supply connected, and follow the steps below.   

Launch MaxIm LE (if purchased with your camera) 
After installing the camera drivers and MaxIm LE from the Installation CD-ROM, launch 
MaxIm LE by double-clicking the MaxIm LE icon on your desktop or by selecting  

ñPrograms > MaxIm LE > MaxIm LEò from the Windows Start menu.   

The first time you run MaxIm LE you will be asked to enter your temporary User 
Registration information.  Enter the Name, Email, Expiry dates and Serial number 
information exactly as printed on the MaxIm LE License Information sheet included in the 
documentation envelope with your camera. 

Caution: Do not enter your real name and email address.  Enter the information 
exactly as printed on the included MaxIm LE License Information sheet. 

 

This license will work for 30 days from the time it is installed.  You must register directly 

with Diffraction Limited to receive your permanent license.  Select Register Online  

from the Help  Menu in MaxIm LE and follow the directions to receive your permanent 

license. 
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Connect the camera  
Select ñCamera Control Windowò from the View menu to open the Camera Control 
Window.   

 

 

MaxIm will open the Camera Control window and display the Setup tab.  After MaxIm is 
installed it must be told which camera to use. 

 

Click the ñSetupò button in the upper left corner under Main CCD Camera.   
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Select ñQSI Universalò from the Camera Model list box.  Click OK. 

 

That will take you back to the Camera Control Window.  If you have a QSI camera with an 
internal color filter wheel youôll also need to tell MaxIm about that by clicking ñSetupò under 
ñFilter Wheelò toward the upper right of the Setup tab.  

 

Select ñQSI Universalò as the filter wheel model.  Click OK.   

 

Note:  The filter wheel must be setup separately from the camera even on 
500/600 Series WS and WSG model cameras where the filter wheel is integral to 
the camera. 

 

 



Q S I  5 0 0 / 6 0 0  S E R I E S  U S E R  G U I D E  

7 

Click the ñConnectò button to establish communication between MaxIm and your QSI 
camera.  If MaxIm fails to connect to the camera, double-check that power is supplied to the 
camera and that the USB cable is securely connected.  Once MaxIm connects to the 
camera the Camera Control window will look like this: 

 

Note:  This example assumes the camera does not have a color filter wheel.  If 
you setup a filter wheel, òQSI Universaló will be displayed under Filter Wheel in 
the dialog above. 

Take an image  
Click the ñExposeò tab along the top of the Camera Control window. 

 

There are several fields and buttons in this window.  On the left is a series of radio buttons 
to select the type of frame to expose.  The options are Light, Bias, Dark and Flat.  Click the 
button next to ñBiasò to select a bias frame.  A bias frame is an exposure with the shutter 
closed of essentially zero exposure time.  The Minutes and Seconds will be grayed 
indicating that the exposure time canôt be modified for a bias frame. Make sure the Delay is 
set to ñ0ò.  Click ñExposeò to take one bias frame. 



Q S I  5 0 0 / 6 0 0  S E R I E S  U S E R  G U I D E  

8 

View the image  
MaxIm will instruct the camera to acquire a bias frame and then automatically download 
and display the resulting image.  Your screen should look something like this. 

 

Your display may vary somewhat from the screen shot above and the image displayed may 
be larger or smaller than that shown depending on your camera model.  While a room 
temperature Bias image isn't very exciting, this does provide confirmation that your software 
and camera are installed and working properly. 

 

Congratulations, you have just connected your new QSI 500/600 Series camera 
and acquired your first image. If youõre familiar with MaxIm LE or MaxIm DL, 
or are using some other camera control software such as CCDSoft from Software 
Bisque, you are now ready to begin taking additional images. 

For all users, but especially if youõre new to CCD imaging with MaxIm LE, we 
suggest you read the entire QSI 500/600 Series Camera User Guide to familiarize 
yourself with all of the features and capabilities of your new QSI camera. 
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Camera Features and Operation  

Camera Attachment Options  
 

 

 

The camera can be attached to your telescope or lens in a variety of ways.  The image 
above shows the industry standard T-Adapter with an attached 2" nosepiece. An optional 
1.25" nosepiece is also available. The T-Adapter is compatible with a wide variety of 
standard accessories.   A larger diameter 2.156ò adapter is available for WSG models. 

An optional C-Adapter adapter is also available. The C-Adapter replaces the T-Adapter and 
is compatible with many standard lenses, lens mounting accessories and other equipment 
such as microscopes. 

Note:  The T-Adapter has industry standard 42mm diameter x 0.75mm pitch 
threads.  The C-Adapter has industry standard 1" x 32TPI threads. Always make 
certain that any device you attempt to thread into either adapter has proper 
matching threads. Some optical components have threads that look like they 
might work, but have slightly different dimensions. Never force-thread 
anything into the adapters. 

Section  

2 
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Using SLR Lenses  

QSI  offers SLR lens adapters for attaching Nikon F-mount or Canon  EOS 
lenses to your QSI camera.  The image at the right shows  a Nikon F-mount lens 
attached to a QSI Model 583ws camera. See Section 6 in this Guide for a list of 

available adapters and compatibility requirements. Note:  Custom mounting 
adapters can be employed to satisfy many unique or non-standard mounting 
requirements. Contact QSI for the dimensions and requirements for custom 
mounting adapters. 

Attach the camera to your telescope  

The picture below shows a QSI 500 Series camera with 2" nosepiece being fitted to the 2" 
focusing tube of a refracting telescope. Always use the largest nosepiece that your 
telescope will allow to minimize any vignetting of your image.    

 

With the correct diameter nosepiece firmly screwed in to the front of the camera, carefully 
guide the nosepiece into the eyepiece adapter on your telescope.  Tighten any retaining 
screw or screws to ensure the camera is stable and will not slip or move when the 
orientation of the telescope changes. 

Electrical Connections  
 
 

The image at the left is a close-
up of the bottom of the camera 
body. All electrical connections to 
the camera are made through the 
three connectors located on this 
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connector panel. The panel is recessed into the camera body to protect the connectors 
when no cables are attached. 

 
 
 

DC Power C onnector  
The camera is ordinarily powered by the included AC power adapter which plugs into the 
middle connector on the bottom of the camera.  The AC power adapter accepts any input 
voltage from 90v to 240v and 50-60 Hz. It is supplied with a region-specific AC power cord. 

Shortly after power is applied to the camera, the Camera Status Indicator on the back of the 
camera will start glowing yellow indicating that the camera is starting up.  The camera will 
make a small ñchirpò sound and then a few seconds later will make a ñchirp chirpò sound 
indicating that the camera successfully completed its initialization steps.  The Camera 
Status Indicator will begin flashing green if the camera is not connected via the USB cable. 
The Camera Status Indicator will glow solid green once the camera is connected to the 
computer via the USB cable. See the Status and Notification discussion later in this 
Section for additional detail. 

 

Note:  Power-up initialization can take up to 6 seconds. It is not possible to 
connect to the camera from the imaging application (MaxIm LE, CCDSoft, etc.) 
during this time. Any attempt to do so will cause an error message to be displayed 
by your imaging application. 

 

Note:  The camera is designed to operate on stable, regulated 12V DC power and 
consumes less than 2 amps at full power.  DC power input above or below 12V 
will decrease the maximum cooling capability of the camera by increasing power 
dissipation or lowering cooling efficiency. If the input voltage is below 11V or 
above 14V the camera will report an error until the voltage is returned to the 
specified range.   See Status and Notification below.   

Caution: Applying an input voltage over 16V or under 10V may 
permanently damage the camera and will void the camera warranty. 

Note:  The camera power connecter uses a standard 2.1mm coaxial DC power 
connector with center positive.   Inside diameter 2.1mm, outside diameter 5.5mm, 
length 10mm. 

 

Caution : Because of the wide range of potential power sources (especially with 
field operations that can also employ batteries, generators, DC inverters, etc.) 
there is the real possibility of damaging your camera and other electrical 
equipment by creating unexpected ground loops and different ground reference 
potentials between your equipment. 
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It is highly recommended that the included AC adapter be used to power the 
camera at all times. If a power source other than the included AC adapter is used, 
it is your responsibly to insure that it is suitable. Avoid sharing the camera DC 
power source with other devices that can produce excessive noise (old technology 
dew heaters, etc.) and possible ground loops that could interfere with the reliable 
operation, or even damage your imaging equipment. 

If you choose to use a power source other than the included AC adapter and are 
uncertain about meeting these requirements, please contact QSI for assistance. 

 

USB C onnector  
The camera's USB interface is compatible with USB 2.0 and 1.1. The included USB 2.0 
cable plugs into the USB port on the camera connector panel.  The other side connects to 
any standard USB port on your computer.  All camera control commands and resulting 
images are passed over the USB cable. 

Note : Do not connect your camera to your computer unless you have 

successfully installed the camera software and drivers.  

After the camera power-up initialization is complete, and the camera's USB cable is 
connected to your computer, the computer will make a Plug-N-Play sound indicating that a 
device was connected to the computer. This means that your camera is ready and is 
listening for commands to be sent over the USB connection. 

 

Note:  QSI 500/600 Series cameras do not draw power from the USB bus. 
Powered hubs are not necessary for operation. 
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Guider Control P ort  
All QSI 500/600 Series cameras have a Guider Control Port that can be used in conjunction 
with MaxIm LE (or other CCD imaging software) to 'guide' your telescope mount for long-
duration astro-imaging. Ordinarily, the Port is only operational if the camera is being used as 
the 'Guider' camera, or if youôre using the QSI camera as your main imaging camera and 
have configured MaxIm to send guider correction signals through the òMain Relaysò.  See 
MaxIm online help for details. 

The Guider Port employs an RJ-25, 6-conductor modular connector. The interface scheme 
is compatible with most modern telescope mounts. Typically, a 6P6C (6 position, 6 
conductor) telephone-style cable is required for connecting the camera to the mount's 
guider input. This type of cable is commonly available at retailers such as Radio Shack. A 
10 ft. version of this cable is supplied with 500/600 Series cameras. 

The image below summarizes how the Guider Port and compatible cable are wired: 

 
 

 
 

Note:  The Guider Port outputs employ optically isolated solid-state switches that 
mimic the traditional behavior of older technology mechanical relays. The optical 
isolation prevents potentially interfering or damaging ground loops between the 
camera and mount. 

This newer approach is compatible with most modern telescope mounts (Meade, 
Losmandy, Astro-Physics, Software Bisque, etc.) that employ logic inputs pulled 
to VCC with a suitable load resistor.  

Adapter cables are available from third parties to connect to other guider port 
configurations, such as the Mini-DIN connector on Takahashi mounts. 

 

Caution:   Do not apply more than 50v or 50ma to the guider port pins. The 
'Common' input must be at ground, or zero volt potential relative to the control 
inputs of your mount. Contact QSI if you are uncertain about your mount's 
electrical characteristics.   
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Cooling the Camera  

Cooling the CCD is essential for successful long exposure imaging. Cooling the sensor 
dramatically reduces the dark current and resulting thermal noise in an image and makes 
long exposures practical. See the discussion in the 'CCD Imaging Overview' Section on 
dark current and noise. 

QSI 500/600 Series cameras use a very efficient thermo-electric cooler (TEC) which relies 
on the 'Peltier Effect' to cool the CCD. When power is applied to a TEC, one side of the 
device gets cold and other side gets hot, essentially pumping heat from the cold side to the 
hot side. All QSI 500/600 Series cameras employ a two-stage TEC to increase the 
differential cooling effect.   

The more power applied to the TEC, the greater the differential cooling and the colder the 
CCD can get. The heat pumped from the CCD, as well as the power dissipated by the TEC, 
creates a significant amount of excess heat that must be removed from the camera. QSI 
500/600 Series cameras employ two different methods for removing this heat. 

Standard Air Cooling  
The back of a QSI 500/600 Series camera acts as a large heatsink with cooling fins 
machined directly into the body. Two automatically controlled cooling fans force air through 
these fins. The movement of air through the cooling fins greatly increases the amount of 
heat removed from the camera. 

Keep in mind that the lowest temperature that the CCD can be cooled is limited by the 
ambient air temperature and the speed of the cooling fans. Achieving very low temperatures 
is easy when imaging outdoors during cooler weather. If it is particularly cold you may not 
even need to turn the fans on. If the weather is warm and humid you may not be able to 
cool the CCD to the desired temperature.  See the specifications for your camera to 
determine the maximum cooling differential you can expect under typical conditions. 

 

Liquid -Assisted C ooling  
Forced air cooling is usually all that is 
needed to reach desired levels of cooling. 
However, in warm weather, indoors, or other 
particularly demanding situations, additional 
cooling can be achieved with the optional 
Liquid Heat Exchanger, or LHX. The LHX 
utilizes recirculating water for more efficient 
removal of heat from the camera. All things 
being equal, the LHX can provide an 
additional 7ºC to 10ºC of CCD cooling. It 
attaches to the rear of the camera body as 
illustrated in the image to the right. The LHX 
includes a thin thermal pad.  Place the 
thermal pad between the LHX and the 
camera body.  Hold the LHX and pad in 
place with the provided screws. 

Water flows through the two hoses, colored 
blue in this picture. Self-sealing quick-disconnect couplings are used to attach the hoses to 
the LHX so that the hoses can be removed easily without leakage of the recirculating water. 
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There are numerous ways of supplying recirculating water for the camera. One of the 
simpler and more common methods for astro-photography is to place a small submersible 
pump into a 5 gallon plastic pail full of cool water. The temperature of this amount of water 
will rise by only a few degrees after a full night of imaging. For additional details on the 
Liquid Heat Exchanger, see the Accessories section below. 

Note:   The Fans can usually be turned off when using the LHX. In fact, the fans 
may actually decrease the cooling ability if the air is warmer than the liquid. 

 

Caution :  It is generally advised that only water be used in the LHX. Coolants 
such as ethylene glycol and some solvents may damage the seals and gaskets.   

Additional cooling tips can be found in the QSI Knowledge base on the QSI web site: 

http://store.qsimaging.com/kb_results.asp?ID=6 

 

How Much Cooling Is Eno ugh  
Good results can be obtained with the CCD cooled to -10ºC when taking modest length 
exposures. This is easy to achieve with forced air cooling on a QSI 500 Series camera 
when the ambient air is at 25ºC (77ºF) or lower.  For most CCDs used in QSI 500/600 
Series cameras, dark current is reduced by half for every å6ºC drop in the temperature of 
the CCD.  Cooling from 26C to -10ºC results in a 64-fold decrease in CCD dark current. For 
more demanding imaging and longer exposures, lower temperatures are desirable. Cooling 
the CCD another 12ºC to -22ºC lowers the dark current further to just 0.4% of the dark 
current at 26C. Cooling below -30ºC results in a diminishing improvement as the noise from 
the dark current is outweighed by the intrinsic read noise of the CCD itself. The camera will 
actively prevent the CCD from being cooled below -40ºC. 

 

Fahrenheit -40F -20F 0F 20F 32F 40F 60F 80F 

Celsius -40C -29C -18C -7C 0C 4C 16C 27C 

 
 

Note:   Refer to the specification sheets at the end of this Guide for the exact 
cooling specifications for your particular camera model. Keep in mind that 
ambient temperature changes, air movement, and even relative humidity can 
affect the temperature that the camera can reach and maintain. 

 

Note:   The cooler is not designed to raise the temperature of the CCD above the 
temperature of the camera body, i.e. it cannot heat the CCD.  If the ambient 
temperature is -10ºC, the cooler cannot bring the CCD temperature up to 0ºC.  
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When using forced-air cooling the body of the camera and the window of the CCD chamber 
can be up to 12ºC warmer than the surrounding ambient air temperature. By definition, the 
camera will be above the dew point (or frost point) and condensation will not form. When 
using the LHX there is the opportunity to drive the enclosure of the camera and the CCD 
chamber window significantly below ambient temperature if the recirculating water is colder 
that the surrounding environment. If the relative humidity is high enough, this action could 
drop the camera below the dew/frost point and condensation will form.  

 

Caution :  Do not allow excessive dew or frost to collect in or on the camera. 
Exercise the normal precautions that you would with any precision optical or 
electronic device. Never use the LHX to drive the camera temperature so low that 
liquid water forms on or in the camera. Under certain conditions excessive 
moisture can impair or damage the optical coatings and the internal electronics. 

 

Controlling  the Cooler  
The operation of the cooler is managed from your CCD imaging application (MaxIm, 
CCDSoft, etc.)  When power is first applied to your camera the cooler is in an inactive state. 
It must be actively turned on. The following explores the technical details of camera cooling 
utilizing MaxIm as the imaging application. For step-by-step operating instructions and 
changing the CCD setpoint temperature, see Section 4. 

Below is a snapshot of the Setup tab in the Camera Control window, shortly after the 
Connect and then Cooler On button was clicked. Notice that the current CCD temperature 
is 12.1ºC, the default Setpoint is -10ºC, and that the cooler power is 100% 

 

 

 

When the Cooler On button is clicked, the camera immediately starts cooling the CCD at full 
power. The cooler will stay at full power until it has cooled the CCD to within a few degrees 
of the setpoint temperature. The camera will then start adjusting the power applied to the 
cooler as it approaches the setpoint temperature. The displayed CCD temperature may 
slightly over-shoot the setpoint temperature as the regulation servo locks. It can take a 
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couple more minutes for the temperature servo to achieve a solid lock. After lock is 
achieved, the camera will keep the CCD temperature within 0.1ºC of the setpoint. 

The following is an image of the same Camera Control window 5 minutes after clicking the 
Cooler On button. Notice that the CCD temperature is now being regulated at -10ºC and 
that the power level has settled in at a comfortable 72%. 

 

 

 

Note:   Depending on the ambient temperature and Cooler setpoint, the time to 
reach the setpoint temperature can take as long as 15 minutes. Once the CCD 
temperature has stabilized at the setpoint value, it is recommended to allow the 
entire camera an additional 5 to 10 minutes to reach thermal equilibrium. 

 

Note:   Best regulation is achieved when the power to the cooler is kept below 
85%. This gives the camera some headroom to compensate for variations in the 
ambient temperature. If the camera cannot reach the desired temperature, it will 
keep trying by running the cooler at 100% power indefinitely. If the desired 
temperature hasnõt been reached within 15-20 minutes, or the power level is 
above 85%, we recommend selecting a higher Setpoint temperature.  

 

Caution :  Be careful not to block free air movement around the camera, or any 
air flow through the fans and cooling fins on the rear of the camera. 



Q S I  5 0 0 / 6 0 0  S E R I E S  U S E R  G U I D E  

18 

Internal Color Filter W heel   

A five or eightïposition color filter wheel is available for some QSI 500/600 Series cameras. 
The filter wheel is designed to hold five or eight standard 1.25" filters, and on some models, 
optional unmounted 31mm filters. The following image shows a 5-position filter wheel with 
filter positions 1-4 occupied by red, green, blue and luminance filters respectively. Those 
are the standard filter positions if your camera was configured at the factory with LRGB 
filters.  

 

 

Note the reflection of the complementary colors  
with this set of LRGB dichroic filters. 

 

 

Note:  QSI offers LRGB filter sets from a number of respected manufacturers, as 
well as other specialized filters for astronomical and medical imaging. Alternatives 
can be specified at the time of order. 

 

The filter wheel is designed to be removed and replaced easily. After detaching the camera 
cover, the filter wheel can be removed by loosening the single shoulder screw in the middle 
of the filter wheel. This allows the user to have additional filter wheels populated with 
different combinations of filters and interchange them quickly while operating in the field. 
See the Care and Maintenance section for details. 
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Advanced Setup Options  

The QSI Configuration dialog box is used to view or change camera settings that are 
seldom modified.  Bring up the Camera Control dialog box and click the Setup tab. The 
camera must be disconnected to proceed further. If necessary, click the Disconnect button. 

 

Click the Setup button in the upper left corner under ñMain CCD Cameraò to open the Setup 
QSI Universal dialog box for the Main camera. If the Camera Model list box does not 
indicate QSI Universal, select it now. 

 

Click the Advanced button. The "QSI Configuration - Main Camera" window will appear as 
illustrated in the following image. 

 

Note:   If you are also using a QSI camera as an Autoguider, you can navigate to a 
similar window entitled "QSI Configuration - Guider Camera" by clicking the 
Setup button in the Autoguider field of the Camera Control window. The steps 
for configuring the Guider camera are identical to those for the Main camera. 
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Note:   The very first time a QSI camera is connected to the computer it will set 
the relevant options shown above to default values based on the configuration of 
the specific camera. From that point forward, the settings are maintained in the 
Windows Registry. All subsequent changes are made to these Registry settings. 
This allows the computer to always know your last selections for each camera and 
restore them the next time you begin imaging. Also, a camera's settings are 
remembered uniquely when being used as a Main camera and when being used as 
a Guider camera. 

 

Only those settings that are relevant to a particular camera model and software package 
are enabled. Options that don't apply are grayed-out.   

Camera Selection  
USB Interface Select the specific QSI camera that you wish to control from 

those listed in the USB Interface list box. Cameras are 
tracked by their serial number. That is the number located in 
parenthesis, and will match the number engraved on the 
camera nameplate / desiccant cover.  
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  If a camera has previously been assigned to another role, it 
will not appear in the list. For example, if a camera is currently 
assigned as the Main camera, it will not appear as an option 
in the Guider selection list box. 

Ethernet Interface Disabled on QSI 500/600 Series cameras 

Note:   If only one camera is connected to the computer, the computer will 
always select that camera by default. You do not need to make the selection here. 
If two or more cameras are available and they match the serial numbers of the last 
camera(s) used for the Main and/or Guider camera, the computer will 
automatically reconnect to them in the same roles.  

The only time you need to actively make a selection is when you have two or 
more cameras available and you want to: 

1) Change the camera roles or 

2) Select a new camera that has never been connected to this computer before.   

 

Status Indicators  
 

LED Indicator On Uncheck to disable the Status Indicator LED on the back of 
the camera. Only normal status indications are disabled. 
Visual indication of errors cannot be disabled.  

Sound On Uncheck to disable the Audible Beeper. Sounds associated 
with camera initialization and error notification cannot be 
disabled. 

Fan Mode Can be set to Off, Quiet or Full-Speed.  Quiet is the default 
setting and is sufficient in most situations. 

  If Off is selected the fans are disabled unless the camera 
temperature begins to exceed a predefined safe level. At that 
point the fans are turned on and run at full speed until the 
camera temperature is reduced to a safe level.  Turning the 
fans off is only recommended when there is an alternate 
source of cooling such as an external fan or the when 
using the Liquid Heat Exchanger. 

  When in Quiet mode the camera runs the fans at reduced 
speed for quieter operation. If more cooling is required to 
maintain the setpoint temperature, the fan speed is increased 
as needed to maintain the desired temperature.  

  Full-Speed mode runs the fans at full speed. 
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Imaging Options  
 

Camera Gain Default setting is ñHighò.  This setting can only be changed on 
cameras that support switchable gain.  With supported 
cameras, gain can be set to ñLowò in order to utilize the full 
dynamic range of the CCD when using on-chip binning.  
ñHighò gain is generally used for 1x1 binning.  ñLowò binning is 
recommended for binning settings other than 1x1. 

Shutter Priority Settings are ñMechanicalò or ñElectronicò.  This setting can 
only be changed on cameras with interline transfer CCDs 
such as the QSI 520 or 640.  In ñMechanicalò priority the 
shutter is closed after each exposure.  In ñElectronicò priority 
the mechanical shutter is left open unless the camera is 
exposing a dark or bias frame.  Electronic priority provides 
the highest possible frame rate when taking short exposures. 

Anti-Blooming Default setting is ñOffò.  This can only be set to On with 
cameras that have CCDs with anti-blooming protection that 
can be controlled or adjusted electronically. 

 

Pre-Exposure Flush This number determines how aggressively the pixels in the 
CCD are flushed between exposures.  The default value is 
ñnormalò.  It can be lowered to decrease the time between 
exposures or increased if you want to ensure that the CCD 
retains less stray charge between exposures. 

  When using full-frame CCDs such as in the QSI 504, 516 and 
532, the Flush options correspond to 0, 1, 2, 4, and 8 flush 
cycles respectively.  With interline transfer CCDs a variety of 
flushing techniques are used by the different Flush options to 
provide increasingly aggressive flushing of stray charge 
before beginning an exposure. 

Show D/L Progress Check this box to enable reporting progress while an image is 
being downloaded from the camera.  The default setting is 
ñOffò. If Show D/L Progress is enabled it will modestly 
increase the download time.  

Optimization With QSI 600 Series cameras, select ñImage Qualityò for the 
highest image quality or ñReadout Speedò for the fastest 
possible downloads.  Default is ñImage Qualityò.  This setting 
is disabled on QSI 500 Series cameras.  500 Series cameras 
always optimize for image quality. 

 

Other Options  
 

Cooling Control, Filter Wheel and Camera Gain will only be enabled in the Advanced 
Dialog Box when using Software packages that do not offer direct control of these features 
from within the application.  If the options are grayed out you should change these settings 
using the features built into the application.  Refer to the User Guide for your camera control 
application for details. 
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Cooling Control For camera control applications that do not provide a way to 
enable cooling or control the set point temperature, cooling 
can be turned on by clicking the checkbox next to ñCooler 
On.ò  The desired temperature can then be set in the text box 
in degrees Celsius. 

Filter Wheel For camera control applications that do not provide a way to 
setup and/or control the filter wheel, click the ñSetupéò button 
to assign names to the filter positions of your camera. 

 

Enable Pixel Masking  
 

Enable Pixel Masking is an advanced function that does not need to be used under most 
normal circumstances.  Click the ñEnable Pixel Maskingò checkbox to expose a table of 
pixel X, Y values (see dialog box below)  Enter the X,Y coordinates of a pixel that you wish 
to be ñmaskedò or ignored. 

When a pixel value is ñmaskedò its original value is replaced with a constant, typically 200.  
It can be used to replace the value of excessively bright or dark pixels with a known value. 
This function can sometimes be handy, for instance, when using guiding or focusing 
software the automatically selects the brightest pixel in the image.  If the brightest pixel is a 
hot pixel rather than a star, then masking the pixel will allow the software to function 
correctly. 

Some camera control applications offer more sophisticated methods of interpolating missing 
values from the values of surrounding pixels.  See your softwareôs User Guide for additional 
details.  

Click ñAdd Pixelò to add another entry in the Mask Pixels table.  If a pixel entry is selected, 
the new entry will be entered above the current entry.  If no pixel is selected, a new entry will 
be added at the end of the table. 

Select a pixel X or Y value and click ñDelete Pixelò to delete that pixel value from the Mask 
Pixels table. 

Note:   Pixel values are stored by camera serial number in the registry of the 
connected computer.  If you have multiple QSI cameras, separate òMask Pixeló 
tables will be automatically maintained for each camera. 
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Advanced Dialog box showing the ñMask Pixelsò table 

 

The current camera status is shown in the text field to the left of the OK and Cancel buttons. 

Click the OK button to save your changes or the Cancel button to abort them. This will 
return you to the Setup QSI Universal window. Click OK again and you'll be returned to the 
Setup tab in the Camera Control window. 
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Status an d Notification  

QSI 500/600 Series cameras utilize a variety of methods to inform the operator of the 
camera's operation, status and other events. A built-in LED Status Indicator and audible 
Beeper provide notification at the camera. In the event of a serious internal error, the 
camera will also pass a descriptive error code back to the controlling application which then 
reports it to the user. 

Camera Status Indication  
There is a small tri-state LED indicator on the camera back just above the connector panel.  
The LED indicates the current status of the camera and any operation that is underway.  
The LED can display green, yellow or red and flash at various rates. 

Camera Operational State Indication  

Green solid In Idle state, not Busy. Ready to accept commands.  

Green flashing USB cable not connected. Not ready to accept commands. 
This only indicates that the USB cable is not physically 
connected between the camera and computer or hub. 

Yellow solid Busy with internal operation. Not ready to accept commands. 
This state is seen while the camera is performing power-up 
initialization, moving the filter wheel or shutter, or when 
uploading an image to the computer 

Yellow flashing Upgrading firmware. The indicator will flash rapidly while 
downloading the camera firmware and then more slowly as it 
is validated. 

Red slow flashing Exposing an image. Flashes once every 4 seconds. The 
camera can still respond to commands (such as abort image 
or read CCD temperature) while in this state. 

 
 

Note:   The Status Indicator can be disabled for the normal camera states 
described above. This may be desirable during long exposures where the light 
from the Status Indicator may be reflected into the telescope. See the Advanced 
Setup dialog box. 

 

Camera Error Indication  
Camera error conditions are indicated by a more elaborate sequence of Red and Yellow 
flashes of the Status Indicator. Errors are classified as Soft errors or Hard errors. Soft errors 
are those that the camera can mitigate, but typically need operator action to resolve. Soft 
errors always begin with one Red flash followed by a number of Yellow flashes. 
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Camera Soft Error State Indication  

Flash Red: 1 

Flash Yellow: 1 The camera is over-temperature. Camera has exceeded the 
40°C maximum recommended operating temperature for the 
internal electronics and enclosure. This sequence will repeat 
every four seconds as long as the camera remains ñover-
temperatureò. 

Flash Red: 1 

Flash Yellow: 2 The CCD is under-temperature. The CCD has exceeded the 
-40°C minimum recommended operating temperature. This 
sequence will repeat every four seconds as long as the CCD 
remains ñunder-temperatureò. 

Flash Red: 1 

Flash Yellow: 3 The camera DC supply voltage is below the 11V minimum 
recommended operating level. This sequence will repeat 
every four seconds until the supply voltage is raised above 
this threshold. 

Flash Red: 1 

Flash Yellow: 4 The camera DC supply voltage is above the 14V maximum 
recommended operating level. This sequence will repeat 
every four seconds until the supply voltage is lowered below 
this threshold. 

Flash Red: 1 

Flash Yellow: 5 The filter wheel has encountered a problem and is no longer 
operational. The camera will still function, but will no longer 
attempt to move the filter wheel. The filter wheel may be in 
any position. Power to the camera must be turned off and on 
to reinitialize the filter wheel. 

Flash Red: 1 

Flash Yellow: 6 The shutter has encountered a problem and is no longer 
operational. The camera will still function, but will no longer 
attempt to operate the shutter. The shutter may be in any 
state. Power to the camera must be turned off and on to 
reinitialize the shutter. 

 

Hard errors occur when the USB communication channel to the computer malfunctions or 
the camera has an unrecoverable internal error. The power to the camera must be turned 
off and on to reinitialize the camera and USB connection to the computer. This class of error 
is generally caused by problems with the USB connection between the camera and 
computer or software and firmware version incompatibility. Hard errors always begin with 
two Red flashes followed by a number of Yellow flashes. 
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Camera Hard Error State Indication  

Flash Red: 2 

Flash Yellow: N The number of yellow flashes of the Status Indicator specifies 
the nature of the camera Hard Error. This code indicates the 
technical nature of the problem.      

 

Note:  Neither class of error indications can be disabled with the Advanced 
Dialog box. If you encounter any of these errors, make a record of the code 
flashed by the Status Indicator. This information will be useful if you need to 
contact QSI Customer Service. 

 

Audible Beeper  
There is a small beeper located inside the camera that is used to provide notification of 
various events. Shortly after power is applied to the camera, the Beeper will make a short 
ñchirpò sound indicating that the camera is entering the Initialization mode. Once the camera 
is fully operational the Beeper will make a ñchirp-chirpò sound. At this point the camera is 
ready to communicate over the USB connection to the computer. 

The Beeper is also sounded in sequence with the Status Indicator when any sort of error 
occurs. A long beep is sounded whenever the Status Indicator is displaying Red and a short 
beep when displaying yellow.  This audible alert is intended to alert the operator in case the 
Status Indicator is not noticed or not visible. 

 

Note:  The Beeper disable function in the Advanced Dialog box does not apply to 
power-on initialization or error notifications. These events are always 
accompanied by the corresponding audible beeper sounds. 

 

Imaging Application Messages  
The imaging applications (MaxIm LE, MaxIm DL, CCDSoft, etc.) may display messages in 
response to activities performed with the camera. Many of these messages have 
straightforward text descriptions of the event. Others messages may include only a numeric 
code. If you get a message indicating an error, record the text message or numeric code in 
the event that you need to contact QSI Customer Support. 
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CCD Imaging Overview  

This section is intended only as a brief overview of CCDs and CCD Imaging.  If you are new 
to CCD imaging there are a number of excellent books that you can use to gain a deeper 
understanding of the issues and techniques.  The subject matter is discussed in the context 
of astronomical imaging, but the basic principles apply to any application.  Two very well 
regarded books on astroimaging that we recommend are: 

Á The New CCD Astronomy by Ron Wodaski 

Á The Handbook of Astronomical Image Processing by Richard Berry and Jim Burnell 

How CCDs wo rk  

Charge Coupled Devices (CCD) work by converting photons into electrons which are then 
stored in individual pixels.  A CCD is organized in a two-dimensional array of pixels.  The 
CCDs used in the QSI 500 Series cameras at the time of printing range from roughly 
400,000 pixels (768W x 512H) to 8.3 million pixels (3326W x 2504H).   

Each pixel can hold some maximum number of electrons.  CCDs currently used in the QSI 
500 Series can hold from 25,500 to as many as 100,000 electrons depending on the 
specific model of CCD.  While integrating (exposing) an image, photons strike individual 
pixels and are converted to electrons and stored in each pixel well.  The effectiveness of 
this process is referred to as Quantum Efficiency (QE). The number of electrons stored in 
each pixel ñwellò is proportional to the number of photons that struck that pixel.  This linear 
response is one of the key traits that make CCDs exceptionally well suited to astronomical 
imaging.  A subject that is twice as bright will build up twice as many electrons in the CCD.  
After an exposure is complete, the electrons in each pixel are shifted out of the CCD and 
converted to a number, indicating how dark or light each particular pixel was.  Those 
brightness values for each pixel are then stored in the image file, typically a FITS file for 
astronomical imaging. 

Types of CCDs  

CCDs are available in a variety of designs and technologies. QSI cameras currently employ 
two different types of CCDs, Full Frame and Interline Transfer, with numerous optional 
features. 

Full -Frame CCDs  
Full-Frame CCDs generally provide the highest sensitivity and the widest linear response 
range of these two types of CCDs.  These characteristics make full-frame CCDs ideally 
suited to astronomical imaging.  Full-frame CCDs must employ a mechanical shutter to 

Section  

3 
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prevent light from falling on the CCD surface while the image is being shifted out of the 
CCD. 

Interline Transfer CCDs  
Interline transfer CCDs work somewhat differently.  In an interline transfer CCD, next to 
every column of pixels is a specialized storage column that is covered by a mask to prevent 
light from hitting the storage 'pixels' underneath.  When an exposure is complete, the entire 
image is shifted in a single operation into this masked storage column.  The pixels which 
are now under the mask stop building additional charge and are shifted out of the CCD in 
the same fashion as a full-frame CCD.  Interline transfer CCDs give up some sensitivity 
because a sizable portion of the potential light gathering surface of the CCD is occupied by 
the masked storage columns.  The key benefit of interline transfer CCDs is that the shifting 
of the image into the masked storage column acts like a very precise electronic shutter 
allowing short, accurate exposures. 

Anti -Bloomi ng  CCDs  
CCDs are subject to an electronic artifact called ñbloomingò that results in bright vertical 
streaks leading from bright objects. 

 

The 60-second image above shows a portion of M42, the great nebula in Orion.  The stars that make up the center of 
the nebula are much brighter than the surrounding nebula.  Taking an exposure long enough to show detail in the 
nebula causes the bright stars to bloom.  Note that some of the other brighter stars around the image also show 
varying amounts of blooming. 

Blooming occurs when taking images of bright objects because when a pixel reaches its full 
well capacity, say 100,000 electrons, the electrons literally overflow into adjoining pixels 
eventually causing them to fill and overflow as well.  In a severely bloomed image, the bright 
blooming trail can lead all the way to the edge of the image.  Data under a ñbloomò is lost 
although there are a variety of processing techniques that can be used to hide pixel blooms 
in a final processed image. 
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Anti-blooming is a feature available on many full-frame and most interline transfer CCDs. 
Anti-blooming technology limits the number of electrons that can accumulate in a pixel by 
draining off excess electrons before they exceed the capacity of the pixel. This can increase 
the dynamic rage of the CCD by as much as 300 times or more. This increase in dynamic 
range greatly reduces the difficulty of imaging bright objects. 

Anti-blooming CCDs make astrophotography more convenient, but with tradeoffs in 
quantum efficiency (QE) and linearity.  Anti-blooming protection requires additional circuitry 
on the surface of the CCD, reducing the physical size and consequently the light gathering 
area of each pixel.  Anti-blooming CCDs also have a non-linear response to light. This non-
linearity becomes significant as a pixel fills beyond 50%. The closer a pixel gets to full-well 
capacity, the greater the rate of electron drainage in order to prevent blooming.  This 
generally isnôt a problem if your goal is producing great-looking pictures of the night sky, but 
anti-blooming CCDs are generally not appropriate for photometric and other scientific use 
where accurately recording the relative brightness of objects is important. 

Microlenses  
CCDs only record the light that hits the photosensitive portion of the CCD.  Most CCDs are 
ñfront illuminatedò meaning that the light strikes the top surface of the integrated circuit 
forming the CCD.  A portion of the surface of the CCD is covered with the electronic circuits 
that make a CCD work.  Light striking a part of the CCD covered by a circuit will not get 
recorded by the CCD. 

The surface of some CCDs is covered with microlenses which focus more of the light 
striking the surface of the CCD onto the photosensitive area away from the circuits. 

The amount of the CCD surface covered in circuits is one factor in determining the quantum 
efficiency (QE) of the CCD.  QE is a measure of how efficiently the CCD converts photons 
striking the CCD into electrons stored in any given pixel.  QE varies by type of CCD and by 
the wavelength of light.  Adding microlenses to a front-illuminated CCD will raise the 
quantum efficiency of the CCD.  Typical peak QE values for the CCDs used in QSI 500 
Series cameras range from 35% to over 80%.  Microlens models tend to have the highest 
QE, while anti-blooming gate models tend to have the lowest QE.  Here is a graph showing 
the QE of the CCDs available in QSI 500 Series cameras at the time of printing. 

 
Note that the non-anti-blooming, full 
frame KAF-3200 and KAF-1603 have 
the highest QE, peaking toward the 
red end of the spectrum around 
650nm.  The anti-blooming, interline 
transfer KAI-2020 and KAI-04022 
have the lowest QE, peaking toward 
the blue end of the visible spectrum 
around 450nm. 
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Single -shot color CCDs  
CCDs are inherently monochrome devices with varying response to different frequencies of 
light.  That varying response can be seen in the quantum efficiency graph above.  Color 
images are normally produced with CCD cameras by taking three (or more) images through 
red, green and blue filters.  The resulting images are then combined using computer image 
processing programs into a final color image.   

Single-shot color CCDs, like those found in almost all general use digital cameras, are 
made by placing red, green and blue filters over adjacent pixels in the CCD.  The image 
processing program then has to separate the three different color images and recombine 
them into a single color image. 

Single-shot color CCDs use a ñBayer 
filterò with alternating red, green and blue 
pixels covering adjacent pixels in a 
checker board pattern as shown in the 
image to the right. 

50% of the pixels are covered in a green 
filter, 25% are covered in a blue filter and 
25% are covered in a red filter.  This 
arrangement is used because the 
human eye is most sensitive to green 
light.  The green pixels correspond to 
luminance and record the greatest detail 
while the red and blue filters record 
chrominance. 
 

After the raw image is read from the 
CCD, a demosaicing algorithm must be applied to the image to produce a complete set of 
red, green and blue images by interpolating the missing pixel values.  This is exactly what 
normal digital cameras do, but itôs all hidden inside the cameraôs electronics.  You only see 
the final processed image.  With a CCD camera, the raw image is read into the camera 
control program and then processed on your computer.  This has the advantage that you 
can directly manipulate the raw image to, for instance, vary the color balance. 

Single-shot color models offer the easiest way to take color images of the night sky.  The 
trade off is reduced QE and detail because of the demosaicing and pixel interpolation. 

Signal versus noise  
For an astronomer, ñsignalò is the photons coming from the stars in the night sky.  In an 
ideal world, there would be steady stream of photons from every bright object and every 
photon striking a pixel would be converted into exactly one electron in the CCD.  Then the 
number of electrons would be precisely counted and converted to a number telling the 
photographer exactly how much light struck each pixel.  Unfortunately, the process of 
converting light to pixel values in a CCD image is governed by some fundamental physical 
laws and other factors that introduce ñnoiseò into an image.  Noise is unwanted variations in 
pixel values that make the image a less than exact representation of the original scene.   

Noise in CCD images can manifest itself in multiple ways, including ñgraininessò in darker 
background areas, ñhotò pixels, faint horizontal or vertical lines that become visible in low 
signal areas of the image, blotchy gradients between darker and lighter regions in a nebula, 
a gradient from dark to light from one corner or side of an image to the other, and especially 

Courtesy Wikipedia 
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as low contrast images ð the result of a reduced signal to noise ratio.  Achieving high 
dynamic range, low noise images from a cooled CCD camera requires a basic 
understanding of how CCDs work and the different sources of noise that can reduce the 
quality of your images. 

Reducing noise in CCD images  
CCD imagers have developed a standard set of calibration techniques to reduce or 
eliminate different types of noise from CCD images.  Calibrating CCD images requires 
taking some special kinds of exposures that are then applied to the ñlight framesò taken of 
the night sky.  The calibration frames are called Dark Frames, Flat Fields and Bias Frames.  
MaxIm LE and other CCD camera control software help gather these extra frames.  After 
the frames are gathered, MaxIm allows you to calibrate your images either automatically or 
manually. 

All the calibration frames should be collected during each imaging session with the CCD at 
the same temperature used for the light frames.  This will ensure the best possible 
calibration of the final images.  Many CCD imagers plan their night of observing to begin 
taking the calibration frames as dawn approaches.  That way, you donôt waste precious 
dark time. 

 

The image above is a single raw 6-minute image of the diffuse nebula M78 in Orion.  Some bright stars are clearly 
visible along with some nebulosity but there are also scattered bright spots around the image caused by òhotó pixels. 

Dark Frames  

Dark frames are used to subtract the buildup of dark current from a CCD image.  Dark 
current is caused by heat.  Similar to how CCDs convert the energy from a photon into a 
stored electron, CCDs also convert the energy from heat into stored electrons. CCDs build 
up ñdark currentò whether the CCD is being exposed to light or not.  The rate that dark 
current builds up is dependent on the temperature of the CCD and can be dramatically 
reduced by cooling the CCD.  Dark current builds up more slowly as the temperature of the 
CCD is reduced. 

Most pixels on a CCD build up dark current at a constant rate but that rate will vary slightly 
from pixel to pixel.  A subset of the pixels in a CCD will build up dark current at a 
dramatically different rate from the average.  These pixels are called ñhot pixelsò or ñdark 
pixelsò.  Hot pixels and dark pixels are both the result of slight imperfections introduced into 
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the silicon substrate of the CCD during the manufacturing process.  Hot pixels are very easy 
to see in a raw CCD image as a series of bright dots placed randomly around the image. 

 

6-minute Dark Frame 

Above is a 6-minute dark frame taken during the same imaging session with the above 
image of M78.  Notice the brighter pixels scattered randomly around the image.   

Note:  The pixel values in this image have been stretched significantly to show the 
variations in the dark frame.  In reality this image is almost completely black with 
perhaps a few hundred òhotó pixels.  This is completely normal and a natural 
consequence of how CCDs are manufactured. 

MaxIm LE automatically scales the visible range of pixels to match the underlying data.  In 
the dark frame shown above the average pixel value is just 203 out of a possible 16-bit 
dynamic range of 0-65,535.  Seeing an automatically scaled dark frame or bias frame can 
be a bit disconcerting for a new imager.  Fear not, this ñnoiseò will be almost completely 
eliminated by subtracting a dark frame from your images. 

Dark frames are subtracted from a light frame to remove the dark current from the image.  
This subtraction removes the slight differences in dark current build-up from pixel to pixel 
along with the larger variations caused by hot or dark pixels. 

In general youôll want to take at least 5 dark frames at each exposure used for your light 
frames.  Youôll get even better results with 9 or more dark frames.  If all your light frames 
were taken with 5-minute exposures, youôll need to collect a set of 5-minute dark frames.  If 
you took both 5-minute and 10-minute light frames, youôll need a set of 5-minute dark 
frames and a set of 10 minute dark frames.  There is a way to reduce the number of dark 
frames you collect by using a set of bias frames but, in general, youôll achieve the best 
results taking dark frames with the same exposure as your light frames. 
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Original image 

 

Original image minus dark frame 

Look at the two images above.  The top image is the original image as it came out of the 
camera.  The bottom image has had the average of 5 dark frames subtracted from it.  Note 
that the bright pixels have been virtually eliminated leaving a smooth black sky background. 

Flat Fields  

Flat fields are used to correct for any irregularities in your optical system, such as vignetting 
or dust motes, and to adjust for any pixel non-uniformity inherent in the CCD.  Pixels in a 
CCD all respond slightly differently to light, typically within 1% to 2% across a CCD. 

All optical systems have a ñsignatureò which gets recorded on the CCD.  This unique 
signature is caused by how light travels through the telescope illuminating the CCD and 
how each pixel responds to that illumination. 
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The image above has been manipulated to highlight the effect of dust motes on a filter or CCD cover glass.  Note the 
3 darker circles.  Because dust will tend to stay in one place over a night of imaging, the variation in pixel values caused 
by the dust can be easily eliminated by properly applying a Flat Field. 

A flat field is created by taking an image of an evenly illuminated subject.  There are four 
common ways to create flat fields. 

Lightbox flats ï  Using a lightbox is usually the easiest way to create good flat fields.  
There are a few commercial lightbox solutions, but many 
astronomers make their own.  You can find plans in The New CCD 
Astronomy and The Handbook of Astronomical Image Processing 
as well as online.  Search for ñTelescope light boxò. 

Twilight flats ï  There is a brief time after the sun sets or just before it rises when 
the sky is appropriate for creating flat frames.  Too early and the sky 
is too bright.  Too late and stars will begin to show up in the image. 

Dome flats ï  If your telescope is in an observatory, you can take dome flats.  A 
dome flat is created by aiming your telescope at a white card 
placed somewhere on the inside of the dome. 

Sky flats ï  Taking sky flats requires taking dozens or hundreds of images with 
the telescope pointed at the sky with tracking turned off.  All the 
images are combined into a master flat to remove the effect of any 
stars moving through the field.  Sky flats require more time than the 
other three options so few amateurs take sky flats.  We recommend 
reading the section on Sky Flats in the Handbook of Astronomical 
Image Processing for additional details on this technique. 

Good flat fields require an exposure time such that the pixel wells are filled to approximately 
half their full capacity.  With a QSI 500/600 Series camera you should strive to achieve 
average pixel values between 20,000 and 30,000 out of a total of roughly 65,000.  You 
should experiment with exposure times to yield that result.  Pixel values are commonly 
called ñADUsò, short for Analog to Digital Units.   

Youôll need to take enough flat fields to average out the noise and then take a series of dark 
frames (called flat-darks) using the same exposure you used for your flat fields.  Just as with 
light frames, the flat-darks are subtracted from the flat fields to remove any contribution from 
dark current.  Taking 16 flat fields and 16 flat-darks will yield excellent results.  Luckily 
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because flat fields tend to use fairly short exposures, you can often take a full series of flat 
fields and flat-darks in just a few minutes. 

The resulting master Flat Field is used to scale the pixel values in the light frame, 
eliminating the effects of pixel non-uniformity, optical vignetting and dust on the optical 
surfaces. 

Bias Frames  

A Bias Frame is a zero-length (dark) exposure intended to measure just the difference 
between the pixels plus any additional noise added during the process of reading the image 
from the CCD and converting it into a digital image file.  Because the CCD pixels are 
emptied immediately before the image is read from the CCD, only a small amount of dark 
current has had a chance to build up, but that rate of accumulation varies slightly for every 
pixel.  Also, reading an image from a CCD is not instantaneous.  Pixels near the bottom of 
the CCD are read later than pixels closer to the top of the CCD so pixels toward the bottom 
tend to have slightly higher pixel values than pixels closer to the top.   

One common use of bias frames is for scaling dark frames.  By subtracting a bias frame 
from a dark frame, you end up with a ñthermal frame.ò  A thermal frame contains pixel 
values showing just the effect of dark current.  Because dark current in any given pixel 
accumulates at a constant rate, a thermal frame allows you to predict with reasonable 
accuracy how much dark current there would be for different length exposures.  However, 
given the opportunity, youôre generally better off taking dark frames that match the exposure 
times of your light frames. 

 

Here is an example bias frame.  Note again that this image has been automatically stretched to show 
variations in the pixel values.  MaxIm LE does this automatically when you view an image file.  All 
the pixel values in the original image fall between 181 and 221 out of a possible range of 0-65,535, 
meaning that the unstretched image would appear almost perfectly and uniformly black. 

Bias frames can also be used to analyze the read noise in a CCD camera.  You can learn 
more about that process on the QSI web site at http://www.qsimaging.com/ccd_noise.html. 

Taking bias frames is easy and takes only a couple of minutes.  When youôre taking your 
dark frames and flat fields, also take a series of at least 16 bias frames.  That completes 
your full set of calibration frames. 

http://www.qsimaging.com/ccd_noise.html
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Stacking Images  

After calibrating each of your raw images with dark frames, flat fields and bias frames, 
combining or ñstackingò multiple sub-exposures can be used to further reduce the noise in 
your images.  Stacking multiple images with a pixel-by-pixel average or median combine 
tends to increase the signal to noise ratio (SNR) of the combined image.  This is because 
random variations in pixel values tend to cancel each other out when multiple images are 
combined, resulting in a smooth background, while non-random pixels, the bright objects in 
the night sky youôre trying to take a picture of, reinforce each other getting you closer to a 
true representation of the patch of sky youôre imaging. 

The benefits of stacking images can be clearly seen by comparing an individual frame to a 
pixel-by-pixel average of multiple frames.   

 

Individual dark-subtracted image of M78 

 

Average combine of 9 dark-subtracted images of M78 

Averaging 9 separate images increases the signal to noise ratio of the final image, allowing 
the faint nebulosity in M78 to become visible and smoothing the black sky background.  
Adding more frames would further improve the results although you do end up in a situation 
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of diminishing returns.  Combining 18 frames will not yield a final image twice as good as 
combining 9 frames.   

Also note that in some cases, doing a ñmedian combineò rather than an ñaverage combineò 
may yield better results.  A median combine is recommended if several of the individual 
frames have unique anomalies such as bright pixels caused by cosmic rays, satellites, 
airplanes, etc.  With at least 5 images, a median combine completely eliminates extreme 
pixel values that occur in individual frames. 

Color images  
Unless youôre using a single-shot color camera such as the QSI 583c, producing color 
images requires taking separate exposures through different colored filters and then 
electronically combining the separate color channels.  The most common method used by 
amateur astronomers for color imaging is called LRGB, where separate color images are 
taken through red, green and blue filters and combined with a set of ñluminanceò images 
taken through a luminance filter.  The luminance filter is required because CCDs are 
generally responsive to frequencies of light that canôt be seen by the human eye.  The 
luminance filter blocks the infrared (IR) and ultraviolet (UV) frequencies that fall outside the 
range of human vision. 

The luminance filter transmits most of the visible light coming from the object.  Because the 
individual frames taken through the red, green and blue filters block roughly ӏ of the total 
visible light, the luminance image will often reveal subtle details not apparent in the 
individual color frames.  This actually works out quite well since the human eye is much 
more sensitive to changes in brightness than it is to changes in color.  Combining a color-
balanced RGB image with a luminance image will yield an LRBG image that the human eye 
would perceive as being very close to the true colors of the object with more fine detail than 
is present in the RGB image on its own. 

MaxIm LE can be used with your QSI 500 Series camera to collect and catalog the various 
filtered images that youôll need to create LRGB images.  As with any images, youôll want to 
collect multiple frames through each filter and then calibrate and combine them in order to 
reduce the major sources of noise.  After calibration, youôll have a master luminance image 
plus master red, green and blue images.  Those master color frames are combined into 
your final image.  In addition to the color image tools in MaxIm you can do further 
processing of your images in Adobe Photoshop or similar photo manipulation programs to 
yield impressive final results. 
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Taking Images with your  

QSI 500 /600  Series Camera  

Launch MaxIm LE  

Note: This section uses MaxIm LE as the camera control application.  If you use a different 
camera control application, it will support similar operations.   

Launch MaxIm LE by double-clicking the MaxIm LE icon on your desktop or select 

ñPrograms > MaxIm LE > MaxIm LEò from the Windows Start menu.  The MaxIm LE 

window should open looking similar to this: 

 

Your window may look slightly different.  If the Screen Stretch and Information windows arenõt open, open them by 
selecting òScreen Stretch Windowó from the View menu, then selecting òInformation windowó from the View menu.  
You can move those windows around your screen to position them where they are most convenient. 

Section  

4 
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Camera Control Window  

Select ñCamera Control Windowò from the View menu to open the Camera Control 
Window. 

 

 

MaxIm should open the window and display the Setup tab.  If another tab is displayed, click 
the Setup tab.  MaxIm may recognize your QSI camera and automatically show it as the 
default camera in the Main CCD Camera field.  If so, the Camera Control Window will look 
like this: 
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 If you donôt see ñQSI Universalò listed in the Main CCD Camera field, click the ñSetupò 
button in the upper left corner under Main CCD Camera.  The window below will open.  
Select ñQSI Universalò from the pop-up menu.  Click OK. 

 

That will take you back to the Camera Control Window.  Click the ñConnectò button to 
establish communication between MaxIm and your QSI camera.  If MaxIm connects 
properly the Camera Control window will look like this: 

 

Note that the current temperature of the CCD is displayed in the ñMain CCD Cameraò field 
toward the upper left of the Camera Control window.  The ñSetpointò is the temperature that 
camera will cool the CCD to, and may be different than shown above. 
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Cool the CCD  
To set the CCD cooling temperature you must first turn Cooling on by clicking the ñCooler 
Onò button just to the left of the Connect button.  After turning cooling on, the Camera 
Control window will look like this: 

 

The camera will immediately begin cooling the CCD to achieve the current setpoint 
temperature.  To select a different setpoint temperature, click the ñCoolerò button at the 
bottom left of the Main CCD Camera field.  That will open the ñSet Camera Coolerò window 
on top of the Camera Control window. 

 

Enter a new temperature in the Setpoint field and click OK. 

The camera will automatically select the right amount of power to apply to the coolers to 
drive the CCD to the correct temperature.  The Main CCD Camera field will show the CCD 
temperature setpoint, the current CCD temperature and the amount of power being applied 
to the CCD.  The camera should reach the setpoint temperature and stabilize within 5 to 10 
minutes depending on conditions and the amount of cooling required. 
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Note:  Please refer to the Cooling the Camera discussion in Section 2 Camera 
Features and Controls for in-depth information on cooling your 500/600 Series 
camera and the available cooling options. 

 

Focusing with MaxIm LE  

Achieving precise focus is critical for producing high quality astronomical photos.  This 
seemingly simple task is surprisingly difficult when using the long focal lengths typical of 
astronomical telescopes.  Fast telescopes with small focal ratios are great for 
astrophotography, but they make focusing even more of a challenge.  The smaller the focal 
ratio, the shorter the critical focus zone.  With some optical systems, the size of the critical 
focus zone can be less than 100 microns (0.1 millimeters), or roughly 0.003 inches. 

MaxIm LE includes a Focus tab to assist with achieving critical focus.  In the Camera 
Control Window, click the Focus Tab. 

 

The Focus tab allows you to take a continuous series of short exposures while adjusting the 
focus of your telescope or other lens.  As stars come into focus they produce a smaller disk 
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of light with more of the total light from the star being focused into a smaller area.  The 
Focus tab window should be set as shown above.  You may need to adjust the exposure 
time in the ñSecondsò field to the time necessary to see a few bright stars.  Setting the 
exposure time as short as necessary to see a few bright stars allows you take more focus 
images in a shorter period of time, generally allowing you to achieve reasonably sharp focus 
fairly quickly.  When you are satisfied with the focus, click ñStopò. 

Note:  The Inspect tab next to the Focus tab can help you achieve critical focus 
by analyzing the area around the brightest point light source in an image.  Review 
the MaxIm LE online help on focusing for additional details. 

Take a single  image  

After connecting to the camera, letting the camera stabilize at the desired temperature, and 
achieving critical focus, youôre finally ready to begin taking ñlight framesò. 

Click on the Camera Control window to make it active.  If the Camera Control window is not 
visible, select ñCamera Control Windowò from the View menu.  Click the ñExposeò tab.  The 
window will look similar to this: 

 

Click ñLightò under the ñTypeò to select a ñlight frame.ò  If you have a camera with a color 
filter wheel, select the filter that you wish to use for this exposure.  On a QSI 500 Series 
model with internal color filter wheel, Filter 4 by default contains the ñLò or luminance filter.  
Set the exposure length in the Minutes and Seconds field.   

Tip:  The Seconds field can accept values up to 32767 seconds so you wonõt need 
to use the Minutes field unless thatõs more natural for you. 

When the settings in the Expose tab are set properly, click the Expose button to begin the 
exposure.  While the camera is exposing the image, the Status LED on the back of the 
camera will flash red.  When the exposure is complete the Status LED will flash yellow while 
the image is being downloaded. 
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View the image in MaxIm LE  

When an exposure has completed, MaxIm will automatically download and display the 
image in a new window. 

 

After downloading the image, examine it to see if the target is properly framed and the 
exposure time is appropriate.  The best astronomical images are achieved when the full 
dynamic range of the CCD is utilized. 

If you like the image, save it by selecting ñSaveò from the File menu.  If you need to adjust 
the framing, focus or exposure, make the necessary changes then click the ñExposeò button 
again.  When youôre happy with the image, save it with an appropriate name so you 
remember what the target, temperature and exposure settings were.  After a long night of 
imaging, it is difficult to remember what settings were used with which image files. 

Tip:  The FITS file format used as the default file format by MaxIm LE and most 
astronomical image processing programs stores a number of settings about the 
image inside the file.  MaxIm LE automatically stores the exposure time, filter 
settings, and CCD temperature among other values associated with each image.  
MaxIm will also store your name, telescope specifications and location into the 
FITS headers if you first enter it in the FITS Header tab of the File > Settingsé 
window. To see the information stored in the FITS header of an image file, select 
òFITS Header Windowó from the View menu. 

Take a series of images  

Achieving the best astronomical images generally requires gathering a lot of light.  Taking 
multiple sub-exposures of, say, 5 minutes, is generally easier than trying to take a single 60 
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minute image.  Tracking errors, improper polar alignment, airplanes, satellites, and cosmic 
rays all conspire to make it difficult to be successful with very long exposures.  Plus itôs a lot 
less frustrating to throw away one 5-minute exposure out of a total of 12 than a single 60-
minute exposure. 

MaxIm makes taking multiple sub-exposures easy.   Itôs even possible to set up an entire 
night of images and then go to sleep.  To set up a sequence of images, bring the Camera 
Control Window to the front and click on the ñSequenceò tab. 

 

Establish a base file name for the sequence of images by entering a text string in the 
ñAutosave Filenameò field.  All the images taken in the sequence will begin with that base 
filename.  Set ñStart atò to 1.  This determines the starting sequence number applied to 
each series of images. 

Click the black arrowhead to the right of ñOptionsò along the right edge of the Sequence tab 
window.  The Options menu will popup.  Select ñSetup Sequenceéò from the Options 
menu.  This will open the ñSetup Sequenceò window. 
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The Setup Sequence window allows you to set up 16 different groups of images to take 
during a single automated sequence.  In the window above, we show 6 different steps in the 
sequence.  MaxIm LE will take five 360 second light frames each with the red, green and 
then blue filters, ten 360 second light frames with the luminance filter, 12 360 second dark 
frames and 16 bias frames.  The total duration of the sequence is shown along the bottom 
under ñDuration.ò  This sequence of images will take 13,502 seconds, or roughly 3 hours 
and 45 minutes. 

The default behavior of MaxIm LE is to take one image in each grouping (e.g., one ñRò 
image followed by 1 ñGò image, etc.) cycling through all the active groups.  If you prefer to 
take all the ñRò images followed by all the ñGò images, etc., click the black arrowhead next to 
Options along the bottom of the Setup Sequence window and select ñGroup by Slotò. 

Note : The òSuffixó field will be appended to each image filename along with a 
sequence number.  So the full filename of the first light frame taken through the 
red filter would be òM78 QSI 0C-001-R360.fitó.  This name identifies the target 
(M78) the camera model (QSI), the CCD temperature (0C), the sequence number 
(001) and the filter and exposure length (R360).  You can of course choose your 
own naming scheme. 

When youôve setup the sequence of images you wish to take, click OK to return to the 
Camera Control window.  Click the ñStartò button to begin the sequence.  All the images in 
the sequence will be run automatically, including moving the filter wheel to the appropriate 
filter, until the sequence is complete.  You are free to perform other tasks, or even take a 
nap, until the sequence completes.  Review the MaxIm LE online help regarding 
Sequences for additional details. 

Image Calibration  

Image calibration is the process of removing or reducing predictable types of noise and 
variations in pixel brightness not caused by light from your subject striking the CCD.  The 
calibration frames should include: 

1. 5 or more Dark frames 
Youôll want at least 5 dark frames taken at each exposure length used for your 
light frames.  If all your light frames were taken with a 5-minute exposure youôll 
only need one set of dark frames.  If you took 2-minute, 5-minute and 10-
minute exposures youôll need a set of dark frames for each exposure length.  

2. 16 Bias frames (for scaling dark frames if necessary) 

 Plus optionally é 

3. 5 or more Flat field frames 

Note:  If you took images through different filters, for the best results youõll want 
separate flat fields with each filter to record the unique optical signature produced 
through each filter. 

4. 16 flat-darks 
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The above numbers represent the minimum of each type of frame you should use.  Taking 
more of each type of frame will further reduce the noise present in each calibration master 
image and improve your final results. 

Why you take different types of image calibration frames was discussed in some depth in 
the CCD Imaging Overview section.  This section covers how to take the required 
calibration frames. 

Dark Frames  
Dark frames are used to subtract the build-up of dark current from raw CCD images.  
Subtracting dark current is generally considered the most important image calibration step. 

In the previous section, we showed how to use the Sequence tab to automatically take a 
sequence of images.  Adding the required dark frames to an automated sequence is often 
convenient because taking dark frames consumes a lot of time.  You need at least as many 
dark frames as you take for each type of light frame, twice as many darks is even better.  
Taking the dark frames in the same sequence as the light frames also ensures that the 
environmental conditions are as close as possible to the conditions when you took the light 
frames.  This ensures the closest match when subtracting dark frames from light frames. 

An exception to this rule is if all the dark time during the night is reserved for taking light 
frames.  Dark frames can be taken after the sun starts to light up the sky as long as no stray 
light reaches the CCD and the camera can maintain the same CCD temperature as the 
morning air starts to heat up. 

To take a series of dark frames, either add them as an additional group in the Setup 
Sequence window or setup a new sequence of just dark frames at a convenient time during 
the imaging session.  If youôre taking 5 exposures each with the R, G and B filters, take at 
least 10 dark frames using the same exposure.  Taking more dark frames reduces the 
noise in the combined dark master, producing higher quality images. 

Bias Frames  
Bias Frames record just the subtle variations in the zero level of each pixel plus any noise 
introduced when reading the image from the CCD.  Taking a complete set of bias frames 
takes only a couple of minutes so in general you should plan on always taking at least one 
set of bias frames during each imaging session. 

To take a series of bias frames, either add them as an additional group in the Setup 
Sequence window, or setup a new sequence of just bias frames at a convenient time during 
the imaging session.  Take at least 16 bias frames at the same temperature as your light 
and dark frames. 

Flat Fields  
Flat fields record any irregularities in your optical system, such as vignetting or dust motes, 
and the slightly different light sensitivity of each pixel on the CCD.  Some astroimagers 
consider flat fields to be optional.  While calibrating images with flat fields does not have as 
dramatic an effect on CCD images as applying dark frames, flat fields are nevertheless 
important for producing the best images with even illumination and the highest possible 
signal to noise ratio.   

Most astronomers take their flat fields either in the evening before the sky gets completely 
dark or in the morning as dawn approaches.  If youôre taking twilight flats the timing of those 
images is critical as you have only a few minutes when the sky is appropriate for taking 
twilight flats.  As with dark frames and bias frames it is important that flat field frames are 
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taken with the CCD at the same temperature as your light frames.  If youôre taking LRGB or 
other filtered images, ideally you should take a set of flat fields through each filter. 

Setup your telescope and possibly your light box to take your preferred style of flats.  Adjust 
the exposure so the average pixel is filled to approximately half its full well depth.  With QSI 
500 Series cameras you should strive for pixel values of roughly 30,000 ADUs.  As with 
dark frames, you should take at least as many flat frames as the light frames you took 
through each filter.  Taking additional flat fields will produce a master flat with less noise, 
yielding higher quality images.  Do not change your focus.  To get correct flat fields, it is 
important that the focus be identical to the focus used for the light frames. 

Flat Dark s 
As with any exposure using a CCD camera, dark current builds up while taking a flat field 
image therefore the dark current must be subtracted with a dark frame taken at the same 
exposure as the flat field.  Taking flat-darks is easier and less time consuming than regular 
dark frames because the exposure time of flat field images is typically much shorter than 
your light frames.  If you take flat field images, it is critical that you also take a series of flat-
darks.  Theyôre easy to take with the shorter exposure, so take at least 15 flat-darks. 

Manual Image Calibration  

MaxIm LE supports both automatic and manual image calibration.  This section describes 
basic manual image calibration in MaxIm LE.  For complete instructions on calibrating 
images, please see the online help in MaxIm LE. 

Subtract Dark Frames  
Begin by creating a master Dark Frame for each exposure length.  A master dark frame is 
created by combining all the individual dark frames using an average or median combine.  
See the section below Combine Frames in MaxIm LE for detailed instructions on 
combining multiple images. 

Tip:  In general, an average combine of multiple images will yield a combined 
image with slightly less noise than a median combine, but this requires that none 
of the frames being combined have any anomalous groups of light or dark pixels 
caused by, for instance, cosmic rays. 

Other programs, such as MaxIm DL, include additional combine methods that 
attempt to provide the low noise of an average combine with the anomalous pixel 
rejection of a median combine.  You will need to experiment to achieve the best 
results. 
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Dark frame showing two cosmic ray hits in lower right hand quadrant 

Inspect your dark frames for cosmic ray strikes or other anomalous pixel groupings.  The 
dark frame above shows two cosmic ray hits in the lower right quadrant of the image.  
Cosmic rays are energetic particles originating from somewhere in space.  They can come 
from any direction and depending on the angle that they strike the CCD can be very long if 
they are nearly parallel with the CCD or just a bright circle if they strike perpendicular to the 
CCD. 

If multiple dark frames in your set each have cosmic ray hits, doing a median combine of all 
the images may yield a better combined image than averaging just the clean frames.  
Experiment to get the best results. 

After youôve created your master dark frame for a given exposure length, subtract it from 
each of the light frames with that same exposure.  Do this by selecting ñPixel Mathéò from 
the Process menu. 
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Screenshot showing Pixel Math command ready to subtract a master dark frame. 

Select your light frame for Image A at the top and your master dark for Image B.  Select 
ñSubtractò for the operation.  Click OK.  You should see many of the bright pixels scattered 
around the light frame, disappear or get visibly darker.  Do this with each of your light 
frames.  After dark subtracting the individual light frames, the light frames can be combined 
into a master light frame.  If you took multiple images through different filters you will need to 
create a master light frame for each color. 

Scale by Flat Fields  
Scaling dark subtracted images by flat fields follows a similar process to subtracting dark 
frames.   

Note:   Taking proper flat fields can be tricky.  If the flat fields arenõt exposed and 
processed properly, scaling an image by an improper flat field can produce results 
worse than not calibrating with flat fields at all.  Experiment and practice for the 
best results. 
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1. Produce a master dark flat following the steps above for creating a master dark frame. 

2. Subtract the master dark flat from each of the flat fields. 

3. Produce a master flat field by averaging the dark-subtracted flat field images. 

4. Finally, divide the master flat field image into each of the dark-subtracted light frames. 

 

Save the resulting images with names that identify the frames as dark subtracted and 
scaled by a flat field. 

See the section below Combine Frames in MaxIm LE for how to combine the now 
calibrated individual frames into a master light frame.  If you took multiple images through 
different filters, youôll need to create a master light frame for each filter (e.g., red, green, 
blue, luminance for LRGB images). 

Automatic Calibration in MaxIm LE  

The section above described manual image calibration in MaxIm LE.  This section 
describes using automatic image calibration in MaxIm.  Many astrophotographers prefer to 
do all their image calibration manually in order to maintain the greatest control over the 
calibration process, but used properly, automatic image calibration can save significant 
amounts of time and yield excellent results.  For complete instructions on calibrating 
images, please see the online help provided with MaxIm LE. 

Begin by gathering all of your calibration frames into the same directory as your light 
frames.  This makes it easier for MaxIm to automatically find and characterize each of the 
calibration frames.   



Q S I  5 0 0 / 6 0 0  S E R I E S  U S E R  G U I D E  

53 

Launch MaxIm LE.  Choose ñSet Calibrationò from the Process menu.  That will open the 
Set Calibration window. 

 

By default, MaxIm expects to calibrate images with bias frames, dark frames and flat fields.  
For this example weôre only going to show calibrating with bias frames and dark frames. 

Note:  MaxIm also has a Calibration Wizard that steps you through the process of 
setting up your image calibration.  For details on the Calibration Wizard please 
consult the online help in MaxIm LE. 

If youôre not calibrating with flats, as in this example, uncheck the three ñFlatò checkboxes 
along the top of the Set Calibration window. 
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In the ñAuto-Generationò panel near the bottom of the window, click the ñéò button to the 
right of the text field and navigate to the folder that contains your images.  In this example 
the images are contained in: 

 My Documents\QSI\Astro Images\M78 QSI 504 060924\ 

Click the checkbox next to ñInclude Subfoldersò if youôve organized the images and 
calibration frames into subfolders within the main folder. 

Click the ñAuto Generateò button in the lower left-hand corner of the Set Calibration window.  
MaxIm will search the specified folder for any calibration frames and automatically organize 
them into different calibration groups based on the type of frame, length of exposure, CCD 
temperature, etc.  This is possible because the FITS file format records all the information 
about each image in the FITS Header attached to each FITS file. 

After auto-generating your calibration groups, the Set Calibration window will look 
something like this: 
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The upper panel lists the groups of calibration frames that MaxIm identified.  The first 
calibration group should be selected.  The lower ñGroup Propertiesò panel lists the files in 
the selected calibration group.  Click on the group labeled ñDark1ò in the upper panel to see 
the files in that group. 

For each calibration group, you can select whether the master image for the group should 
be created by averaging each pixel in the individual frames or using the median value of 
each pixel.  Setting the ñCombine Typeò to average will generally yield the lowest noise 
master frame but any irregularities in any of the images, such as from a cosmic ray hit, will 
show up in the master image.  Setting the combine type to Median eliminates any 
excessively dark or light pixels in an individual image from affecting the master but produces 
a master image with slightly more noise than an average combine of clean individual 
calibration frames. 
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If MaxIm correctly identified all the calibration groups you created, you can click OK to close 
the Set Calibration window.  Optionally you can click the ñReplace w/Mastersò button next to 
the Auto-Generate button.  When Replace w/Masters is pressed, MaxIm will combine all the 
images in each calibration group and save the combined master image in the same 
directory as the individual frames.  It will then modify the calibration groups to use each 
master frame.  Using ñReplace w/Mastersò saves a little time while calibrating images 
because MaxIm only has to load and process one master file as opposed to all the 
individual frames. 

After clicking ñReplace w/Mastersò the Set Calibration window will look like this: 

 

 Note : MaxIm assigns a name to the master calibration frames that shows all the 
unique characteristics about the calibration group used to create it. 

Click ñOKò to close the Set Calibration window. 

Calibrate Images in MaxIm LE  
Now that youôve told MaxIm about all your calibration frames youôre ready to calibrate your 
light frames.  Weôre going to show an example of calibrating the ñluminanceò or ñLò images.  
If youôre taking LRGB images, the same techniques will be applied to processing the 
images taken through the red, green and blue filters. 

Open all the luminance images in MaxIm LE.  In this example 9 luminance images were 
taken with an exposure of 360 seconds each.  All the luminance images were given a 
filename suffix of ñLò when the image sequence was setup using the Sequence tab in the 
Camera Control window.  Select multiple files from within a folder and drag them all at once 
into MaxIm or select ñOpenéò from the File menu and open individual or multiple files in a 
single operation. 

With the files open in MaxIm, select ñCalibrate Allò from the Process menu. 
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MaxIm will apply each of the calibration groups you specified in the Set Calibration step to 
each of the open images. 

You can then choose to save the calibrated images or just leave them open in MaxIm.   

Tip : Be careful when saving the individual calibrated images not to overwrite the 
original image files.  It is often useful to go back to the original uncalibrated 
images. 

Combine Fr ames in MaxIm LE  

After youôve calibrated the individual light frames, you can then combine them into a master 
frame.  Continuing with the example above, weôll combine the 9 luminance images into a 
master luminance image. 

Select ñCombineéò from the Process menu.  If youôre working with very large files, you can 
also choose ñCombine Fileséò from the File menu.  It performs exactly the same function 
but works on files from disk rather than memory.  The ñCombineò command works best if all 
the images you want to combine fit in your computerôs memory. 
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The dialog box above will open showing a list of all currently open files on the left.  Select 
individual image files and then click the ñ>>ò button to add them to the list of Selected 
Images or click the ñAdd Allò button to add all the images.  Click OK. 

This brings up the Combine Images dialog, which performs two related functions.  It aligns 
and then combines the individual images.  Alignment is important because unless you have 
absolutely perfect polar alignment and tracking, the position of individual stars will shift 
slightly between images. 

MaxIm LE provides 3 types of manual alignment.  Other programs, such as MaxIm DL 
provide additional types of alignment including fully automatic alignment.  For this example 
weôre going to use the Align Mode, ñManual 2 stars.ò  This 2 star alignment will shift and 
rotate individual frames to line up the stars in the images. 

MaxIm makes manually aligning the images painless.  If youôre aligning on stars, click the 
checkboxes next to ñUse Centroidò and ñAuto Nextò.  With ñUse Centroidò MaxIm will 
calculate the center of mass of a point object like a star allowing sub-pixel alignment.  With 
Auto Next set, each time you click on an image to pick the alignment star, MaxIm will 
automatically proceed to the next image.  Select a star fairly near the edge of the first image 
and click on it.  That sets the position of the first star in the alignment process.  If ñAuto Nextò 
is set, MaxIm will display the next image file.  Click on the same star in each image. 

In the dialog box below we are already half way through the alignment process.  Note that 
the ñCenter Pointò is set to ñ23, 57ò and the ñStar 2ò button is depressed. 
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The first image file is again the top 
window in MaxIm.  Select a second 
alignment star near the opposite edge 
of the image.  Repeat the process by 
clicking on the second star in each 
image.  When you click on the star in 
the last image, MaxIm will make a bell 
sound indicating that the alignment 
process is complete. 

Make sure the Output field is set like 
you want: Sum, Average or Median.  
Average will generally yield the best 
results if none of the images have any 
cosmic ray hits or other anomalous 
errors.  Click OK to combine the 
images.  MaxIm will open a new 
window with the combined image.   

 

 

 

 

 

 

Combined image of M78 
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If everything was done correctly the calibrated and combined image should show additional 
detail with less noise and greater contrast than the individual frames.  Changing the range 
of displayed brightness levels in Screen Stretch window will show additional detail in 
different parts of the raw image file.  Save the image with a name that allows you to identify 
this image as a combined master image. 

MaxIm provides additional tools for manipulating images.  Please refer to the online help on 
Image Processing in MaxIm for additional details.  After performing image calibration in 
MaxIm, many astronomers prefer to move the individual or combined image files into Adobe 
Photoshop or other dedicated image processing program for further processing. 

Binning  

Binning allows you to combine multiple pixels into what are effectively larger pixels with up 
to sixteen times the surface area and sensitivity as an individual pixel.  The standard binning 
mode is 1x1 meaning that each logical pixel is equal to one physical pixel.  The QSI 500 
Series supports symmetrical and asymmetrical binning up to at least 3 pixels in either axis.  
Some models offer additional binning options.  Larger binning modes like these provide 
increased sensitivity and dynamic range at the expense of resolution.  Asymmetrical binning 
(e.g. 1x3 or 3x2) is not commonly used but can be very useful for specialized applications 
such as spectroscopy. 

The following image illustrates how rows and columns of pixels are combined when binning an 
image. Notice how the effective dimensions of the CCD changes with the degree of binning. 

 
 1x1 Binning 2x2 Binning 3x3 Binning 
 3326x2504 1663x1252 1108x834 QSI 583 image size 

Binning other than 1x1 is typically used in two different situations.  First, the human eye is 
much more sensitive to subtle changes in image brightness than it is to small changes in 
color.  This can be taken advantage when producing color images by taking luminance 
images through the ñLò filter binned 1x1 and red, green and blue images binned 2x2.  When 
combined with the luminance image the 2x2 binned color image is almost indistinguishable 
from using 1x1 binning for the color frames. 

The second situation where 2x2 or higher binning is used is when seeing conditions donôt 
support high resolution imaging.  If each pixel on your CCD ñseesò 2 arc seconds of the sky 
through your telescope and the local seeing conditions are only 4 arc seconds, you wonôt 
benefit from the increased resolution offered by 1x1 binning.  In this case, binning 2x2 will 
yield optimal results in a shorter amount of time. 
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Select the binning mode for a single exposure in MaxIm LE on the Settings tab of the 
Camera Control window. 

 

Note : MaxIm automatically adjusts the Width and Height fields to represent the 
size of the resulting image.  In the example above 2x2 binning has been selected.  
This reduces the size of the resulting image of the QSI 504 from 768x512 to 
384x256. 

You can also select different binning modes when setting up a sequence of images under 
the Sequence tab of the Camera Control window. 

 

In the example above, the red, green and blue filtered images will be taken with 2x2 
binning.  The luminance image through ñFilter 4ò will be taken with 1x1 binning.  Note that in 
this sequence the color images are set for an exposure of 240 seconds.  This would require 
a separate set of 240 second dark frames for the color exposures in addition to the 360 
second dark frames for the 1x1 luminance frames. 
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Note:  When using binning other than 1x1, the pixels are combined inside the 
CCD before reading and converting the combined pixel charge to a numeric 
value. This results in lower overall noise than reading each pixel separately and 
combining them mathematically in your computer.  With 2x2 binning for 
instance, only one pixel value (representing a square of 4 physical pixels) is fed 
through the CCD output amplifier resulting in ¼ the noise compared to reading 
each of the 1x1 pixels separately. 
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Using the internal Color Filter Wheel  

Your QSI 500/600 Series camera may include an internal 5 or 8-position color filter wheel.  
The color filter wheel is controlled automatically by MaxIm LE or other camera control 
software.  If you ordered LRGB filters with your 
camera, the default order of the filters is as 
shown below: 
 

1. Red 

2. Green 

3. Blue 

4. Luminance 

5. Empty 

 

In the picture above with the front cover 
removed from the camera, filter position 5 is shown empty over the shutter opening.  Note 
that the dichroic filters reflect the light not passed by the filter (e.g. the red filter reflects 
cyan).  Specify which filter to use for a single exposure in the Expose tab of the Camera 
Control window by selecting the filter in the pop-up menu 

 

In a sequence of images, you can specify a different filter for each sequence group. Refer to 
the Setup Sequence window in the previous section.  That sequence shows four sequence 
groups, one each through the Red, Green, Blue and Luminance filters (shown as Filter 4).  
Before each image is exposed the correct filter will be rotated into position. 

For information on removing the front cover of the camera to add, remove or clean the color 
filters, refer to the Care & Maintenance section. 
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Shutting down your camera  

QSI cameras can safely be turned off by removing the power cable at any time, however it 
is best to let the temperature of the CCD rise close to the air temperature before removing 
power. 

 

Click on the Setup Tab in the Camera Control window.  Click the Cooler Off button to turn 
off the CCD cooler.  The fans will continue to run dissipating heat from the thermoelectric 
coolers.  When the temperature of the CCD begins to stabilize near the air temperature, 
click Disconnect to disconnect from the camera.  

Unplug the power plug from the camera. 

Controlling your camera with other software  

QSI camera drivers are included on the installation CD for MaxIm DL from Diffraction 
Limited and CCDSoft from Software Bisque.  Follow the instructions in the installer if you 
want to control your QSI 500/600 Series camera with either of these applications. 

You can also write custom applications to control your QSI camera on Microsoft Windows 
or Linux systems using our ASCOM-compatible Windows COM API or Linux API.   

For complete details on the Microsoft Windows or Linux API and other applications that 
please visit the Software and Drivers page on the QSI web site, 
http://www.qsimaging.com/software.html.  

 

http://www.qsimaging.com/software.html
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Guiding  

The QSI 500/600 Series camera can be used as you main imaging camera or as an 
autoguider.  MaxIm LE supports the following cameras as autoguiders.  Other camera 
control software, such as MaxIm DL support additional autoguiders with a QSI camera. 

Autoguider support  in MaxIm LE  

Á Fishcamp Starfish Á Any QSI camera 

Á Meade DSI Pro, DSI Pro II, DSI Pro III Á Any recent SBIG camera 

Á Orion StarShoot Á Video DirectShow 

Á Orion StarShoot Autoguider Á Lumenera 

Á Starlight Express Lodestar  

 
QSI 500 Series cameras have a Guider port on the bottom of the camera.  This port sends 
guider correcting signals to your telescope mount.  Connect the included guider cable from 
the camera Guider port to the AutoGuider port on your telescope mount.  The guider 
correction signals output by the QSI 500/600 will work with most modern telescope mounts 
using the included guider cable. 

 
The photo to the left shows the 
guider cable connected to the 
AutoGuider port on a Losmandy 
Gemini System.  Please refer to 
your camera and mount 
specifications to confirm your 
mount is compatible with the 
signals from the QSI 500/600 
Series camera.   

 

 

Using an 

AutoGuider  

This section provides basic 

Section  

5 
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instructions on how to use your QSI 500/600 Series camera as your main imaging camera 
and set up a separate camera on a guide scope for guiding.  For this example, weôre using 
a Meade DSI Pro as the autoguider.  For complete instructions on guiding, including a step-
by-step tutorial, please see the Online help in MaxIm LE. 

Setup your QSI 500/600 Series camera as described above.  Hook up your guider camera 
to your guide scope and connect the guider camera to your computer.   

 

Go to the Setup tab of the Camera Control window.  Click the Setup button in the 
Autoguider panel.   

 

Follow the instructions that came with your autoguider camera to enable and configure the 
camera.  Click OK to return to the Setup tab of Camera Control Window.  Click Connect.  If 
your cameras are hooked up and configured correctly, the status panels for each camera 
will show the current status of your main CCD camera and your Autoguider.  
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Click the ñGuideò tab to the left of the Setup tab.  The Start button will be enabled if the 
autoguider camera was setup correctly. 

 

Click the black arrowhead to the right of ñOptionsò below the Stop button and select ñGuider 
Settings.ò 
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In the guider settings window, make sure that ñMain Relaysò is selected in the ñControl Viaò 
pop-up list under Autoguider Output.  This instructs MaxIm to send the autoguider control 
signals through the Guider port on the QSI 500/600 Series camera.  If your autoguider 
camera also has a guider port, you can select ñGuider Relaysò to send the signals through 
the autoguider camera.  MaxIm supports additional methods of generating the correct 
control signals.  See the online help in MaxIm LE for complete details.  Click OK to close the 
Guider Settings window and return to the Guide tab of the Camera Control Window. 

You may need to focus your guide scope.  You can take an image with your guide camera 
by pressing the Start button.  Set the exposure only as long as necessary to still yield well-
defined stars.  Shorter exposures allow quicker cycles between guiding exposures and 
smoother guiding.  

The first time you press Start with a new exposure length, MaxIm LE will automatically take 
a dark frame.  Follow the instructions on screen.  Press Start as necessary to take 
additional images while focusing your guide scope.  Stop when you are satisfied with the 
focus and exposure length. 



Q S I  5 0 0 / 6 0 0  S E R I E S  U S E R  G U I D E  

69 

 

MaxIm LE automatically selects the brightest star as the guide star.   

You are now set up for guiding.  Continue with instructions in the online help in MaxIm LE to 
calibrate your autoguider and begin tracking the selected guide star. 

For complete instructions on autoguiding in MaxIm LE please refer to the ñAutoguidingò 
section of the online help in MaxIm. 

Using a QSI 500 /600  Camera as an AutoGuider  

Your QSI 500/600 Series can be used as an autoguider with another camera as your main 
imaging camera.  If using MaxIm LE, the main CCD camera must be set as a QSI camera 
or ñNo Camera.ò  The full version of MaxIm DL and CCDSoft support additional options.   

Note: This section provides basic instructions on how to use your QSI 500/600 
Series camera as an autoguider.  For this example, there is no main CCD camera.  
For complete instructions on guiding, including a step-by-step tutorial, please see 
the online help in MaxIm LE. 

Click the Setup tab of the Camera Control window.  Click the Setup button below Main CCD 
Camera and select ñNo Cameraò under Camera Model and click OK to return to the 
Camera Control Window.  Click the Setup button below Autoguider and select ñQSI 
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Universalò under Camera Model and click OK to return to the Camera Control Window.  
Click Connect. 

 

Click the Guide tab and again click the black arrowhead to the right of ñOptionsò below the 
Stop button and select ñGuider Settings.ò  Select ñGuider Relaysò in the ñControl Viaò pop-up 
list under Autoguider Output.  This instructs MaxIm to send the autoguider control signals 
through the Guider port on the QSI 500 Series camera now being used as the autoguider. 
Click OK to close the Guider Settings window and return to the Guide tab of the Camera 
Control Window. 

Everything else in the section above Using an Autoguider applies when using the QSI 
500/600 Series camera as the autoguider.  Continue with Using an Autoguider above for 
additional details.   

Note:  For complete instructions on guiding, including a step-by-step tutorial, 
please see the Online help in MaxIm LE. 
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Accessories  

T-mount adapter  

 
The T-mount adapter plate attaches to the front of the camera body.  
It comes standard on all QSI 500 Series cameras.  The T-mount 
adapter is threaded with standard T-mount threads, 42mm diameter 
by 0.75mm pitch. 

 

 

2ó nosepiece 
The 2ò nosepiece screws into the T-mount adapter plate.  The 2ò 
nosepiece allows the camera to be mounted in any 2ò eyepiece 
adapter.  The 2ò nosepiece is threaded to accept a standard 
mounted 48mm filter. 

 

1 ĳó nosepiece 
The 1 ıò nosepiece is optional and screws into the T-mount 
adapter plate.  The 1 ıò nosepiece allows the camera to be 
mounted in any 1 ıò eyepiece adapter.  The 1 ıò nosepiece is 
threaded to accept a standard 1 ıò filter. 
 
 

C-mount adapter  

The C-mount adapter replaces the standard T-mount adapter on 
the camera faceplate.  The C-mount adapter is threaded with 
standard C-mount threads, 1ò x 32tpi.  There are two different 
versions of the C-mount adapter plate which provide the correct 
focal depth for slim and mid-sized QSI 500 Series cameras.  You 
must use the correct version of the C-mount adapter plate for your 
body style in order to achieve focus at infinity.  A C-mount adapter 
will mount to full-sized 500 Series WS model cameras but standard 
C-mount lenses will not achieve focus at infinity. 

Section  
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SLR lens adapter  

SLR lens adapters are available for the following lens mounts: 

Á Canon EF (EOS) 

Á Nikon F 

The SLR lens adapter provides the correct focal distance for 
specified lenses when threaded to the standard T-mount adapter on 
full-size ñwsò model cameras.  Standard extension tubes or T-mount 
extenders should be used to achieve the correct focal distance with 
slim or mid-size bodies.  Mid-size bodies will require a 0.5ò extension 
tube.  Slim bodies require a 0.825ò extension tube. 

Liquid heat exchanger  

 
The liquid heat exchanger (LHX) provides additional cooling of the 
CCD beyond what can be achieved using the standard air cooling.  
The liquid heat exchanger attaches to the back of the QSI 500 
Series camera using four screws.  Refer to the camera 
specifications to determine the temperature differential that can 
typically be maintained when using the LHX. 

 

Recirculating pump  

The recirculating pump is used to pump water through the liquid heat exchanger.  

Color filter wheel  

 
Cameras with an internal color filter wheel include one filter wheel 
and an optional set of LRGB filters.  Additional 5 or 8-position color 
filter wheels can be ordered to hold 1.25ò or unmounted 31mm 
filters.  With additional color filter wheels you can load a second set 
of filters, such as narrowband filters or photometric filters, and easily 
replace the entire filter wheel.  See the Care & Maintenance section 
below for instructions on removing and installing the color filter 
wheel. 

 

See the WSG User Guide Supplement for details on accessories specific to WSG models. 

See the Accessories page on the QSI web site for complete details on available 
accessories: http://www.qsimaging.com/accessories.html
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Care & Maintenance  

Cleaning the exterior  

The QSI 500/600 Series cameras are machined from high quality 6061 aluminum with a 
very durable anodized finish that resists most scratches and fingerprints.  Use a soft cloth to 
remove dirt or spots from the exterior surface of the camera. 

Installing or removing color filters  

Always remove the color filter wheel when installing or removing filters.  To change filters or 
replace the color filter wheel the front cover of the camera must be removed.  Place the 
camera face up on a stable surface.  Using the included 3/32ò Allen wrench, carefully 
remove the screws holding the camera cover to the camera body.  Lift the cover straight up 
to expose the color filter wheel.   

Remove the color filter wheel by 
unscrewing the screw in the 
center of the filter wheel.  
Carefully lift out the color filter 
wheel. 

The standard color filter wheel 
accepts 1 ıò mounted filters.  
Any filter can be screwed into 
any of the 5 or 8 available 
positions. 

To replace the color filter wheel a 
slight pressure must be applied 
with the outside O-ring against 
the capstan motor that drives the 
color filter wheel.  Carefully line 
up the center screw and press 
the filter wheel O-ring gently 
against the capstan motor.  

Lining up a filter or empty filter position over the shutter opening can help to achieve the 
proper alignment.   

Screw in the center screw until it is quite snug.  5 inch-pounds or more of force if you have a 
torque wrench.  Stainless steel screws naturally "lock" with anodized aluminum.  The screw 
is tight enough when you can hear the screw "break free" when it is loosened. 

Section  
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Installing or removing 31 mm color filters  

Some QSI 500/600 Series Color Filter Wheels are configured to hold unmounted 31mm 
filters.  Filter wheels capable of holding 31mm unmounted filters have a screw hole between 
each filter position. 

    

Note the retaining screws in the image above between each filter position which hold the 
unmounted 31mm filters in place.   

 

Different retaining screw/washer combinations are used to hold different thickness filters.  
Filters up to 3mm thick (e.g. Astrodon, Astronomik) use the configuration shown above to 
the left.  5mm thick IDAS filters use the configuration to the right. 

Note:  A thin spacer or O-ring may be required to be placed under unmounted 
filters that are less than 3.5mm thick in order to raise the top surface of the filter 
above the top of the filter wheel recess so the retaining screw can hold the filter 
firmly in place.  The correct spacer should have been supplied with your filters or 
filter wheel. 
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Installing  the 8-position Color Filter Wheel  

Always remove the color filter wheel when installing or removing filters.  To change filters or 
replace the color filter wheel the front cover of the camera must be removed.  Place the 
camera face up on a stable surface.  Using the included 3/32ò Allen wrench, carefully 
remove the screws holding the camera cover to the camera body.  Note that 2 or 4 of the 
screws holding the 8-position cover to the body are longer than the rest.  The longer screws 
go through the 8-position CFW Adapter Plate and screw directly into the QSI 500/600 
Series body, shown with blue arrows below.  Lift the cover straight up to expose the color 
filter wheel. 

 

Remove the color filter wheel by unscrewing the screw in the center of the filter wheel.  
Carefully lift out the color filter wheel.  To replace the color filter wheel a slight pressure must 
be applied with the outside O-ring against the capstan motor that drives the color filter 
wheel.  Carefully line up the center screw for the 8-position CFW (shown above) and press 
the filter wheel O-ring gently against the capstan motor.  Lining up a filter or empty filter 
position over the shutter opening can help to achieve the proper alignment.   

Screw in the center screw until it is quite snug.  5 inch-pounds or more of force if you have a 
torque wrench.  Stainless steel screws naturally "lock" with anodized aluminum.  The screw 
is tight enough when you can hear the screw "break free" when it is loosened. 






















